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INTRODUCTION 
 
 
This user manual describes the features of the SimulationView application. 
 
The SimulationView – Strategy Simulator is a software tool developed specifically to simulate 
control strategies with FoundationTM Fieldbus function blocks and ladder logic IEC 61131-3 
standard. 
 
 
Integrated to SYSTEM302  

• It is not necessary to export configurations for simulation;  
• Access data directly from SYSTEM302 database;  
• The SYSTEM302 application tools use the simulation automatically and transparently; 
 

OPCTM Communication 
• The simulated data are visible through the SYSTEM302 OPCTM Server 
• Any supervisory software and SCADA based on OPCTM can benefit from simulation. 
 
 

SimulationView runs on Microsoft® Windows. 
 
This manual refers to version 1 of SimulationView available on SYSTEM302 version 8.2. 
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Section 1 
 

1.1 

INSTALLATION AND CONFIGURATION 
 

Installation 
SimulationView is installed by the SYSTEM302 Installation media, along with all the other 
integrated applications you will use to configure, maintain and supervise your plant. 
 
Please refer to the SYSTEM302 Installation Guide, which describes the procedures to install the 
SYSTEM302. 
 
After installing the SYSTEM302 get the SimulationView - Strategy Simulator license.  
 
 

Getting a license 
 
There are two ways to get the SimulationView license. One version is protected via Hard Lock 
(Hard Key) and another via software (Softkey). 
 
When using Hard Key, just connect it in the appropriated computer port (parallel or USB ports).  
 
When using SoftKey, it is necessary to get a License Key through a Smar contact. For this, use the 
application LicenseView, in the Studio302 interface. 
 
Click Softkey, and then, Request License. 

 
 

Fill in the fields correctly, enter the LN (License Number) code that was received with the purchase 
of the product. See this code on the keyring that came with the installation media. A file (.zip) will be 
generated in the \Smar\OleServers folder for the user to send to Smar. Use the email 
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(techsupport@smar.com.br) or access the Technical Support channel through the website 
(www.smar.com.br). 
 
After sending the email to Smar, a key will be generated according to the corresponding LN level. 
This key will be returned via the email informed in the previous form. This generation is not 
automatic and, therefore, you must wait for business hours. 
 
After receiving the email from Smar, launch the LicenseView application again, enter the key 
obtained in the DFI OLE Server field and click Grant License Keys. If everything is correct, a 
message will notify you that the license has been accepted. 
 

NOTE 
The academic license has some limitations. For the simulation mode, Syscon and 
LogicView for FFB tools, included in the package, only can access one local OPC 
Server. The remote access is blocked to the academic license. Refer to SYSTEM302 
Installation Guide for further information about licenses. 

 
 

Starting the SimulationView 
 
To start the simulation, launch the SimulationView. 
 

In the Studio302 toolbar click  - SimulationView - Strategy Simulator.  
 
If the button is not activated, check the preferences in File →Preferences. Click the SimulateView 
tab and select the Enable the System302 simulation mode option. 
 
However, to work with SimulationView first create a new network adapter, and configure it. See the 
next topic. 
 

Configuration 
SimulationView needs creating a new network adapter to work. This adapter is used exclusively for 
simulation, being isolated from the control network or corporate network. Or even, allowing you to 
work on a machine that does not have a network connection. This adapter will be automatically 
created by the IP Configurator tool at the first time that it was run. If there is any error and the 
interface is not created automatically refer to Appendix A for the manual creation procedure. 
 

Setup tool 
 
At each SimulationView execution the Setup tool will perform the configuration checking. They 
are: 
 
Database checking 
The SimulationView will run only if the database has at least one area. Otherwise, the following 
window will appear. 
 

http://www.smar.com.br/


Installation and Configuration 
 

1.3 

 
 

Create an area and try to run the SimulationView. 
 
License checking 
The Setup tool checks if the SimulationView is licensed. If noncompatible hard key is found 
neither a soft key the Setup tool does not allow the SimulationView execution. 
 

 
 
 
The figure above shows the license checking failure. Connect a hardkey or get a softkey and click 

the button  for a new checking. If the Setup tool has already closed run again the 
SimulationView. For further information refer to Getting a license topic. 

 
Network checking 
The Setup tool checks if there is a Microsoft Loopback Adapter properly installed. 
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If it was not installed the Setup tool will show the detection failure as in the figure above. Click the 

button  to start the IP Configurator. For further details about this tool refer to IP Configurator 
topic. 
 

 
OPC configuration checking 
The Setup tool checks the Smar OPC Server configuration. This check compares the IP NIC with 
the one configured as First IP in the IP Configurator tool.  

 

 
 
 

The previous window shows the NIC configured for network adapter different from the one used for 

simulation. Click the button  and the NIC will be configured with correct IP and the simulator will 
be ready to run. The Setup tool will appear as in the next figure. 
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The window above shows the configuration ready to run on SimulationView. Select the Close and 
run SimulationView when ready option to run automatically the SimulationView if the 
configuration is correct. Even with this option checked the Setup tool will stop running the 
SimulationView when detect any inconsistency. 
 
If there is any problem with the database and it was not detected the following window appears. In 
this case try restarting the database or restart the computer. 
 

  
 
 
IP Configurator 
 

The IP configurator tool is launched by the button  on the Setup tool interface or on the main 
SimulationView screen. 
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The following window will appear confirming that the SimulationView will be closed to initiate 
the IP Configurator. Click Yes. 
 

 
 
The IP Configurator tool is used to configure the IPs that will be used in simulation. Refer to the 
next topic to configure the Microsoft Loopback Adapter interface. 

 
 
Configuring the "Microsoft Loopback Adapter" interface 
 
Now that we have a network adapter, we will configure it to use the SimulationView. The simulator 
uses network IPs the same way as the real equipment, so we need to configure 32 valid and not 
repeated IPs more one IP to be used by the Server. 
 

 
1. In the IP configurator on the first Simulator network interface section the Microsoft 

Loopback Adapter interface should appear selected. If no interface is selected redo the 
step titled Creating a Microsoft Loopback Adapter type network interface. Refer to 
Appendixx A for further information. 

 

 
 

2. In the section IP Configuration enter an IP number in the First IP field. Note that this first 
IP address must be used as address of OPC Server, and must not be used for any other 
purpose. This IP is of the Microsoft Loopback Adapter interface. 
 
3. Click the GENERATE IP TABLE button to create a table with 32 IPs in sequence 
generated from the First IP that was chosen earlier. The IP sequence will appear in the IP 
Table field. See the following figure. 
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4. Click APPLY if you agree with the generated configuration. Otherwise, return to step 2 to 
generate another IP sequence. 
 
5. If the Actual IP Configuration section has the correct IPs, click KEEP to maintain the 
configuration. Confirm the operation and click CLOSE to exit from the IP Configurator. 
 
6. A confirmation message appears to confirm the IPs change. In case you confirm, the new 
configuration will be applied to the selected interface. In the Actual IP configuration section 
the current IPs are shown. 
 
7. A success message appears indicating that the process finished. 
 
8. Close the IP configurator and execute again the SimulationView. 

 
 
Configuring the IPs of the plant HSE devices  
 
This procedure is optional on SimulationView because the IPs for all HSE devices in the plant are 
automatically configured. 
 
In the main SimulationView window select one area in the Areas section. All areas of the 
Studio302 database are listed here. 
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In the Simulated nodes section select the first item of the list. 
 

 
 
In the Item configuration section, in the Available IP field, select the IP that will be assigned to the 
item, and double-click it. 
 
Select the remaining items and proceed as described above for all HSE devices of all 
configurations.  
 

NOTE 
Remember do not select an IP that is assigned to the Server NIC in the System302 
ServerManager. 
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Adjusting the System302 ServerManager to work with simulation 
 
This procedure is optional on SimulationView, because the Setup tool always gives the option to 
configure the OPC. If the user needs to modify the configuration manually, follow the steps 
described in this section. 
 
The simulation works with its own virtual network, so the user needs to inform the SYSTEM302 that 
this network will be used, and not the automation network. If you are using an academic license the 
simulator only runs on this virtual network, and this configuration is not necessary. 
 
To adjust the System302 ServerManager execute it. Click the System302 ServerManager - OPC 
Server Management icon in the Studio302 toolbar.  
 

 
 
The next window will appear:  
 

 
 

Choose Network.  
 
In the NIC option choose the first IP generated by SimulationView - IP Configurator, and click 
Apply. This IP is of the Microsoft Loopback Adapter.  
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Now the system is already configured to use the virtual network adapter. 
 
 

Operation 
 
Start/Stop simulation through the notification icon 
 
When the SimulationView is running the user can start, or stop the simulation through the icon that 
is on the Windows Notification Area. 
 
Simulation stopped:  

 
 
Simulation running:  

 
 
To start or stop the simulation, access the contextual menu by right-clicking the SimulationView 
icon:  
 

 
 
Select Stop to stop all areas in execution. 
 
Select Start to start all database areas (areas properly configured).  
 
To check if the simulation is running or not, besides the color of the icon, a notification message is 
also displayed when the mouse moves over it. 
 
Simulation running:  
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Simulation stopped:  

 
 
 

NOTES 
• Starting or stopping the simulation by the notification bar, the SYSTEM302 

continues in simulation mode. Only the ladder and blocks processing stop. 
• Whenever the simulation is stopped and then restarted a configuration 

download via Syscon must be done. 
• The status of all TAGs of the OPC Server in the simulation mode are reported 

with "Local Override" substatus. 
 
 
SimulationView Limits 
 
Table of limits: 
 

Maximum number of HSE devices per database 32 
Maximum number of function blocks per simulation session 11264 

 
 

NOTE 
Depending on application, to use the maximum number of blocks and HSE equipment 
may cause loss of system performance, requiring that the computer configuration that 
runs the simulation is higher than that recommended by Smar to run SYSTEM302 
without simulation. 
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Understanding the main SimulationView screen 
 

 

Here are the component parts of the main SimulationView screen. 
 
1. Main Menu. 
 
File 

• Exit: Finishes the SimulationView stopping all simulation that is in progress. 
 
Simulation  

• Launch the simulation: Starts the simulation of all database areas. 
• Refresh: Updates the areas list to be used when a new area is added to the database 

while the SimulationView is running.  
• Stop the Simulation: Stops the current simulation.  
• Show simulation report: Shows a summary of the number of devices in simulation. Only 

the HSE devices are represented in the simulation, all function blocks of devices 
connected to the bridge channels are simulated on the proper bridge. 

 
Help  

• Content: Opens the software’s help. 
• About: Shows the software version. 

 
2. Areas 
 
It lists all areas of the current database. This list is obtained directly from the SYSTEM302 database. 
 

3. Button  
It starts the simulation of all devices of this area. 
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4. Button  
It stops the simulation of all devices of this area. 
 

5. Button  
It updates the list of areas. It is used when a new area is added to the database while the 
SimulationView is running.  
 

6. Button  
It launches the network configurator. This tool is used to configure the network adapter that is used 
by SimulationView. See the Configuring the "Microsoft Loopback Adapter" interface topic.  
 
7. Nodes 
It lists the devices simulated of the area selected in 2. It lists the devices connected to HSE channel. 
Only the HSE devices are represented in the simulation, all function blocks of devices connected to 
the bridges’ channels are simulated on the own bridge. 
 

8. Button  
It starts the simulation for the device selected in 7. 
 

9. Button  
It stops the simulation for the device selected in 7. 
 

10. Button  
It updates the device list for the area selected in 2, and looks for processes that are running on 
background. 
 

11. Button  
It opens the software help pointing to the "Configuring the IPs of the HSE devices" topic. 
 

12.  Button  
It assigns the IP selected in 13 to the device selected in 7. 
 
13. Available IP 
It lists the network adapter IPs used for simulation. 
 
 

Viewing the simulation 

To view the area simulation, click  - SimulationView - Strategy Simulator in the Studio302 
toolbar.  
 

Run the Syscon by clicking  in the Studio302 toolbar. Check if the automatic commissioning 
option is selected in the Syscon. Select File →Preferences on the main menu. Click the 
Simulation tab, and the following window will appear: 
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By default, the Automatic Commissioning option is already selected. Keep selected if you do not 
want to do the commissioning manually.  
 

IMPORTANT 
The commissioning process does the correlation between the actual and configuration 
devices and must be performed every time the plant is set on online. 
This procedure is optional for simulation; it can be used to train operators for this 
procedure. 

 
 
Open the area that will be simulated in the Studio302 interface. The file will open in Syscon. Then, 

active the Online mode by clicking  on the Syscon toolbar. A window similar to the following 
will appear. 
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The Simulation mode is indicated in the title bar by the text (Simulation) beside the area name.  
It is also indicated at the bottom of the window by Simulation Mode. Work normally as if in a real 
environment. For further details, please refer to Syscon manual. 
 
If the IP address configured in the simulation is different from the NIC the following error message 
appears immediately after the Syscon is set on Online Mode: 
 

 
 
Stop the simulation, run the System302 ServerManager and configure correctly the IP of Microsoft 
Loopback Adapter interface. 
 
The control logic also can be simulated in the LogicView for FFB. Edit the logic from the Syscon 
that should already be in simulation mode. Both Syscon and LogicView for FFB must be in Online 
mode. 
 
A window similar to the following will appear. 
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The simulation mode is indicated in the title bar by the text SIMULATION. It is also indicated by the 
background color of the work area. This color can be changed in Tools →Options. The following 
window will appear: 
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In the Simulation Color option change the background color. 
If the license is academic, when LogicView for FFB is set on online mode the remote server 
connection is disabled. 
 
Work normally as if in a real environment. For further details, please refer to LogicView for FFB 
manual. 
 
 

IMPORTANT 
If the user wants to simulate a control strategy that is not configured for this, the user 
must quit the simulation mode, and only then, to configure the new area. 
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Section 2 
 

2.1  
 

TROUBLESHOOTING 
 
 
If you are experiencing difficulties with the simulator, the following Q & A topics may help you: 
 
 
1. I started the SimulationView and received the following message:  
"There is no loopback ethernet interface configured! The SimulationView Network configurator will 
be executed. Note that SimulationView will be closed and must be reinitiated after the 
configuration."  
This message indicates that no network "Microsoft Loopback Adapter" was configured. Follow the 
instructions on Creating a network interface “Microsoft Loopback Adapter” topic to solve the 
problem. And then, launch the SimulationView again. 
 
2. I started the SimulationView and received the following message:  
"There are unconfigured equipments\n\nPlease Access SimulationView and configure IP for those 
equipments:"  
This same message shows a device list (PD Tags). This message indicates that there are devices 
without IPs assigned. Follow the instructions on Configuring the IPs of plant HSE devices topic to 
solve the problem.  
 
3. The simulation is performing, but on Syscon all devices are without communication.  
Check on the Windows notification area if the SimulationView icon is present.  
Moving the mouse over this icon it should display the message SimulationView (running). If the 
message SimulationView (stopped) appears follow the instructions on Start/Stop simulation 
through the notification icon topic. 
 
4. I started the SimulationView and received the following message:  
Title “Fail configuring IP!” and the message “There are no free IP to use! The selected network 
adapter doesn't have the number of IP necessary to simulate your entire database. Or you are trying 
to simulate more than 32 equipments at the same time.”  
 
First hypothesis: You have selected various areas to be simulated and the total number of HSE 
devices exceeded 32. See the SimulationView Limits topic. 
 
Solution: Exit from SimulationView, and on Studio302 select only the configurations that are 
necessary at this moment. Try starting the SimulationView again. 
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Appendix A 
 

A.1 

CREATING A "MICROSOFT LOOPBACK 
ADAPTER" TYPE NETWORK INTERFACE 
 
Follow the steps bellow to create a network interface Microsoft Loopback Adapter, using the 
Windows 10 operating system. 
 
Step 1 – Right-click the Start button, and the following window will appear: 
 

 
 
Step 2 - Select Device Manager. 
 
Step 3 – In the Device Manager window, select Network Adapter. See the next figure. 
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Step 4 – Click the Action option in the menu of Device Manager window. 
 
Step 5 – Select Add legacy hardware. See the next figure: 
 

 
 
Step 6 – In the window that will appear, click Next. 
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Step 7 – Select the option Install the hardware that I manually select from a list (Advanced), 
and then, click Next. 
 

 
 
 

Step 8 – Select Network Adapters in the list, and then, click Next. 
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Step 9 – Select Microsoft in the manufacturers list. 
 

 
 
 
Step 10 – Select Microsoft KM-TEST Loopback Adapter from the Model list, and then, click Next. 
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Step 11 – To start installing the new hardware, click Next again. 
 

 
 
 

Step 12 – The installation is complete. Click Finish to close the wizard. 
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